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I C ROBOTICS 
FRC ROBOT PROGRAMMING 
GETTING STARTED WITH LABVIEW 
 

What are we going to do? 
Work through all the steps from software download and installation through hardware configuration 
and deployment of a base LabVIEW program so that you have a drivable FRC robot. We then make 
some simple changes so that you can control a single additional motor. 

 

What do I need to know? 
Only basic computer skills are required to complete this exercise - no prior programming knowledge 
is necessary. 

 

What is LabVIEW? 
LabVIEW is software produced by National Instruments that (in their words): 

“… is a highly productive development environment for creating custom applications that interact 
with real-world data or signals in fields such as science and engineering.” 

For FRC it provides a quick way to develop software for an FRC robot using a graphical toolset. 

 

What do we need? 
You will need the following items to complete this exercise 

• 1 x robot (our 2015 robot Fluffy features in the pictures here but any robot using an 2015 
FRC Kit of Parts (KOP) based on Talon Motor Controllers will be fine – see appendix A for a 
specification of the relevant parts for this exercise) 

• 1 x 12v battery (charger will be useful too) 
• 1 x laptop (charger and mouse will be useful too) 
• 1 x joystick 
• 1 x programming cable (USB A male to USB B male) 
• 1 x network cable (Ethernet RJ45 male to RJ45 male) 
• 1 x “NI Software for FRC 2015” (file: NI_FRC2015.zip) 
• 1 x “FRC 2015 Update Suite” (file: FRCUpdate2015.1.0.zip) 
• 1 x software activation code 
• Safety glasses for everyone working on the robot 
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• 4 x Wooden blocks to raise the robot wheels from the ground when testing  
 

 

 
 

 

 

 
  

  

 
  

Are there any other useful resources? 
The following references may be useful as they were used to construct this document. It is not 
necessary to read all of these.  

There should be enough information available in this document to complete the exercises without 
having to trawl through all of these sites / documents. That said, there are some dead spots during 
the installation (exercise 1) so you might want to visit some of these links then to familiarise yourself 
with the material that is out there while you are waiting.  

REF#01: National Instruments (NI) software (see https://decibel.ni.com/content/docs/DOC-34731) 

REF#02: FRC Game Manual (see 
https://rps01.usfirst.org/frc/manual/2015/FRC2015GameManual.pdf) 

REF#03: WPILIB Screen Steps - 2015 FRC Control System (see 
https://wpilib.screenstepslive.com/s/4485) 

https://decibel.ni.com/content/docs/DOC-34731
https://rps01.usfirst.org/frc/manual/2015/FRC2015GameManual.pdf
https://wpilib.screenstepslive.com/s/4485
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REF#04: Create an NI User Account (see https://lumen.ni.com/nicif/create.xhtml) 

REF#05: What is LabVIEW? (see http://www.ni.com/newsletter/51141/en/) 

REF#06: FRC LabVIEW Quick Start Guide (see https://decibel.ni.com/content/docs/DOC-34661) 

Ok, let’s get started! 
The exercises described here need to be completed in order. 

 

EXERCISE 1: installing the LabVIEW and FRC software on the laptop 
 

(CREDIT FOR THIS SECTION: https://decibel.ni.com/content/docs/DOC-34731) 

Before you can start to program your robot you need to install NI LabVIEW on your PC. This section 
describes the steps for completing the install: 

(a) if someone in your team has already downloaded the software  files (NI_FRC2015.zip and 
FRCUpdate2015.1.0.zip) then proceed to the next step. Otherwise, go to the link in REF#01 
and download both files by following the on screen instructions. This will take a while 
because they are large files, you also need to provide an NI account which you can set up as 
described in REF#04 – you may want to ask your mentor to complete this step on your 
behalf if you do not have a good data plan or you just don’t want to register with NI! 
 

(b) Create a staging directory C:\Stage and copy the software files into that directory 
 

(c) Create additional staging directory at C:\Stage\NI_FRC2015 
 

(d) Expand the NI_FRC2015.zip file into the C:\Stage\NI_FRC2015 directory 
 

(e) Run C:\Stage\NI_FRC2015\setup.exe 
 

(f) Follow all defaults to complete the installation of NI LabVIEW, make sure all components are 
selected for installation (note that you will need to provide the serial number / activation 
code during this process – please refer to the code on the reverse of the “NI Software for 
FRC 2015” envelope, the number will usually be 9 characters long with two letters and 7 
digits: “X99X99999” 
 

(g) Create additional staging directory at C:\Stage\FRCUpdate2015.1.0 
 

(h) Expand the FRCUpdate2015.1.0.zip file into the C:\Stage\FRCUpdate2015.1.0 directory 
 

(i) Run C:\Stage\FRCUpdate2015.1.0\setup.exe 
 

https://lumen.ni.com/nicif/create.xhtml
http://www.ni.com/newsletter/51141/en/
https://decibel.ni.com/content/docs/DOC-34661
https://decibel.ni.com/content/docs/DOC-34731
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(j) Follow all defaults to complete the installation of the FRC Update Suite (if prompted for a 
password use R3C3CL3RU$H2015)(if prompted for a serial number then provide the code on 
the reverse of the “NI Software for FRC 2015” envelope) 
 

(k) Restart PC 

 

EXERCISE 2: configuring the DLINK radio 
 

(CREDIT FOR THIS SECTION: https://wpilib.screenstepslive.com/s/4485/m/13503/l/144986-
programming-your-radio-for-home-use) 

Communication between robots and driver stations at FRC tournaments is via WIFI. This mechanism 
can also be used during development so that you do not have to keep plugging in a cable each time 
you want to load a program change to your robot. It also has the benefit that when testing you are 
not having to stand close or be connected to your robot! 

The DLINK DAP1522 Bridge / Access Point is also referred to as the “Radio”. And this looks after the 
WIFI connections at the tournaments and when working at home in your lab/classroom/workshop. 
The radio device looks like this: 

 

When you attend a tournament your radio device will be reprogrammed. So on return from a 
tournament and when you first receive your KOP you will need to configure your radio. The 
remainder of this section describes how to accomplish this. 

For this exercise the radio needs to be removed from the robot, it will still need a power supply so 
you may choose to leave the power connected to the robot and have the robot power switched on. 
Alternatively, if you can source an external power supply for the radio then by all means use that. 
The back panel for the radio looks like this: 

 

Note the mode selection switch - this should be set to 2.4GHz as shown. 

The label on the underside of the robot tells you which model you have (revision B in this case), 
make a note of this as you will need to know this when you are running the configuration software: 

https://wpilib.screenstepslive.com/s/4485/m/13503/l/144986-programming-your-radio-for-home-use
https://wpilib.screenstepslive.com/s/4485/m/13503/l/144986-programming-your-radio-for-home-use
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NOTE: if you have difficulty connecting to your robot wirelessly later on it will 
most likely be that you skipped a step in this section. If that is the case simply 
work through this section again and make sure that you complete every step in 
the order described.   

 

 (CREDIT: https://wpilib.screenstepslive.com/s/4485/m/13503/l/144986-programming-your-radio-
for-home-use) 

(a) Login to your PC as Administrator 
 

(b) Disable WiFi connections on your computer, as it may prevent the configuration utility from 
properly communicating with the bridge: select “Start” > “Control Panel” > “Network and 
Sharing Center” > “Change Adapter Settings” then right click on “Wireless Network 
Connection” and select “Disable” 

 

NOTE: anywhere in this document you see the word “select” it means “left-click 
with the mouse”    

 
(c) Connect your computer to the radio device (i.e. the DLINK DAP1522 Bridge / Access Point) 

using an Ethernet cable - you can use any of the Ethernet ports on the back of the radio 
device 
 

(d) Using the “Network and Sharing Center” disable all other wireless or wired networks – this 
step is important and may result in the radio not functioning correctly if you skip it 
 

(e) Using windows file explorer, navigate to C:\Program Files (x86)\National 
Instruments\LabVIEW 2014\project\Bridge Configuration Utility and double-click on FRC 
Bridge Configuration Utility.exe to launch the program (for 32-bit machines the path is 
C:\Program Files\National Instruments\LabVIEW 2014\project\Bridge Configuration Utility) 
 

https://wpilib.screenstepslive.com/s/4485/m/13503/l/144986-programming-your-radio-for-home-use
https://wpilib.screenstepslive.com/s/4485/m/13503/l/144986-programming-your-radio-for-home-use


File: icrobotics.frcrobotprogramming.gettingstartedwithlabview.20151129.docx 
Version: 20151129 
Author: Ian Jessett 

Page: 6 of 31 

 

(f) If your computer is running Windows Vista or Windows 7, a prompt may appear about 
allowing the configuration utility to make changes to the computer.  Click "Yes" if the 
prompt appears 
 

(g) Use the pop-up window to select which Ethernet interface the configuration utility will use 
to communicate with the radio device. On Windows machines the Ethernet interfaces are 
typically named "Local Area Connection" or “Ethernet”.  Note that the configuration utility 
can’t program a bridge over a wireless connection it must be a wired connection. 
 

 If no Ethernet interfaces are listed then select "Refresh" to re-scan 

 Select the interface you want to use from the drop-down list 

 Select "OK" 

 

 
(h) In the “FRC Bridge Configuration Utility” window select the bridge model and operating 

mode, you can find the “mode” switch on the back of the radio device. The device revision is 
printed on a label on the underside of the radio device: 

 Select which DAP1522 revision you are configuring using the drop-down list 

 Select which operating mode you want to configure (for most cases, the default 
selection of 2.4GHz Access Point will be sufficient)  
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(i) In the “FRC Bridge Configuration Utility” window, follow the instructions “ to program your 
wireless bridge”: 
 

i. Ensure the mode switch on the back of the radio device is set to “AP 2.4GHz” 
ii. Connect power to the bridge 

iii. Connect Ethernet cable from your PC to the bridge 
iv. Wait for the blue power and AP lights to turn on 
v. In the “FRC Bridge Configuration Utility” window enter your team number (e.g. 

5584) and the WPA Key “password” then select “Configure”  
 

(j) Wait while the radio device is configured, throughout the configuration process, the window 
will indicate: 

 The step currently being executed 

 The overall progress of the configuration process 

 All steps executed so far 
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(k) If errors are reported: 
 

i. Confirm that you are logged in as Administrator 
ii. Confirm that you have disabled all wireless connections 

iii. Confirm that there are no other network devices attached to your PC 
iv. Reset the bridge to factory settings as described in the “FRC Bridge Configuration 

Utility” window under “If asked to reset your wireless bridge” 
 

(l) Once the configuration is complete: 
 

 Press "OK" on the dialog window 

 Press "OK" on the main window to return to the settings screen 
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(m) You can now disconnect the Ethernet cable from the radio device  
 

(n) Re-install the radio device in the robot, there will be a power connection and two Ethernet 
cables to connect (one from the radio device to the roboRIO and a second on from the radio 
device to the webcam, note that you can use any of the ethernet ports on the radio device) 

 

EXERCISE 3: imaging the roboRIO 
 

In exercise 1 you installed NI software on to the PC, we will now use this PC to upload an “image” to 
the roboRIO. This “image” establishes an operating environment on the roboRIO that can be used to 
upload and run LabVIEW programs. This image stays on the roboRIO until we re-image at a later 
date, you do not need to re-image each time you turn on your robot. You should only need to repeat 
this exercise if a new image version is distributed by NI. 

(CREDIT: https://wpilib.screenstepslive.com/s/4485/m/13503/l/144984-imaging-your-roborio) 

(a) Before you start, confirm that the roboRIO is correctly connected to the PowerDistribution 
Panel (PDP) as described in appendix A. 

https://wpilib.screenstepslive.com/s/4485/m/13503/l/144984-imaging-your-roborio
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NOTE: before you power up the robot for the first  time you should place the 
chassis on wooden blocks so that there is no chance it can cause any damage if it 
goes out of control. This practice should be implemented every time you make 
substantial changes to the software on the roboRIO and/or you are power the 
robot and are uncertain what software is on the robot already. As unlikely as this 
might seem you should never assume that the code that somebody has left on 
the on the robot will behave as you expect it to!   

 

(b) Ok, so now you can turn on the power on your PC and the robot. 
 

(c) Connect the USB cable from your PC to the roboRIO, make sure you use the connection 
shown in the diagram below: 

 

(d) Note that this is a USB-A to USB-B cable so the ends are different, the squarer connector 
goes to the roboRIO, the flatter connector to the PC. 
 

(e) A few seconds after connecting the USB to the PC you should see a pop-up in the bottom 
right corner  that tells you the drivers have automatically installed. 
 

(f) Using the windows file explorer find the imaging tool, this is a file called 
roboRIO_ImagingTool.exe, this will be at: 
 

• C:\Program Files (x86)\National instruments\LabVIEW 2014\project\roboRIO Tool\... 
(for 64 bit PCs) 

or 

• C:\Program Files\National instruments\LabVIEW 2014\project\roboRIO Tool\... (for 
32 bit PCs) 

 
(g) Double click with the mouse on roboRIO_ImagingTool.exe. The “FRC roboRIO Imaging Tool 

Version X.Y” window will appear. 
 

(h) The top left pane shows any roboRIOs that are connected to the PC, the right pane shows 
information for the roboRIO selected in the top left pane. The bottom left pane should show 
a list of one or more “image” zip files. At this point the image files are on your PC hard drive, 
the imaging process takes one of these image files and unpacks it onto the roboRIO. 
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(i) We will now complete the imaging process: 
 

 Make sure the roboRIO is selected in the top left pane 

 Enter your team number in the text box (top right) 

 Make sure the Disable RT Startup App box is unchecked (bottom right) 

 Tick the “Format target” checkbox (on the left) 

 Select “Reformat” to launch the imaging process 

 

(j) If all is well a window will pop up telling you that “The roboRIO image was successfully 
updated …”. This also mentions an IP address – you do not need to record this: 

 

(k) Select “OK” then “Close” in the main window to terminate the Imaging Tool. 
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(l) Restart the roboRIO by pressing the Reset button on the roboRIO, the reset switch is located 
on the bottom right corner of the roboRIO, the button is “soft” so you need to hold it in 
firmly until the roboRIO LEDs switch off 

 

 

EXERCISE 4: creating your first LabVIEW program 
 

We will now create a program using one of the built in NI templates. Using these pre-existing 
projects will enable you to get your robot up and running very quickly. It is recommended that you 
use a pre-existing project and modify it to your needs rather than “re-inventing the wheel”. 

 

NOTE: The programs in the National Instruments LabVIEW product are referred to 
as “Virtual Instruments” or “VIs”. You will see later that these programs are saved 
on your PC with the extension “.vi”. 

 

(CREDIT: https://wpilib.screenstepslive.com/s/4485/m/13811/l/145335-creating-building-and-
loading-your-benchtop-test-program) 

(a) Before beginning, make sure that you have installed LabVIEW for FRC and the FRC Driver 
Station and that you have configured and imaged your roboRIO as described in exercises 1 
to 3. 
 

(b) Launch LabVIEW from Windows “Start” page – search for "NI LabVIEW 2014" to launch the 
“FRC Getting Started” window. Alternatively you can select the following icon on your 
desktop if it is present: 

 

(c) In the “FRC 2015 Getting Started” window select  the “Projects” tab then the “FRC roboRIO 
Robot Project”: 

https://wpilib.screenstepslive.com/s/4485/m/13811/l/145335-creating-building-and-loading-your-benchtop-test-program
https://wpilib.screenstepslive.com/s/4485/m/13811/l/145335-creating-building-and-loading-your-benchtop-test-program
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(d) the “Create New FRC Robot Project” dialog box will be displayed: 
 

 Pick a name for your first robot project (we used “2015 Robot Project” as the 
name for these exercises, but you can call it whatever you like) 

 Select a folder to place the project in (the default will probably be ok, otherwise 
Create a project folder on your C: drive) 

 Enter your team number 

 Set “Project Type” to “Arcade Drive Robot – roboRIO” 

 Select “Finish” 
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EXERCISE 5: uploading and running your program on the roboRIO 
 

Ok, so we created a LabVIEW program in the previous exercise, how do we upload this to the robot 
so that we can confirm that it actually works? 

In this exercise we will upload and run the program. 

Note that the method described in this exercise only loads the program in to volatile memory – if 
you remove the power to the roboRIO (i.e. turn the robot off) then the program will be need to be 
uploaded again before you can run it. The method in this exercise is used during the development 
phase as we want to modify-upload-test multiple times. To upload a program that will survive a 
power cycle of the robot, refer to exercise 6. 

 

NOTE: If you have any difficulties downloading code to your robot in this exercise 
then repeat the radio configuration exercise. 

 

(CREDIT: https://wpilib.screenstepslive.com/s/4485/m/13811/l/145335-creating-building-and-
loading-your-benchtop-test-program) 

(a) Safety first – goggles on, robot on wooden blocks 
 

(b) Power up the robot 
 

(c) Wait for two blue lights to appear on the radio 
 

(d) Disable any wired network connections (i.e. remove all cables between the robot and your 
PC, also recommend disabling the wired network connection  via “Start” > “Control Panel” > 
“Network and Sharing Center” > “Change Adapter Settings”, right click on the “Local Area 
Connection” (or “Ethernet”) and select “Disable”) 
 

(e) Double check, there should be no Ethernet cables or USB cables connected between the 
robot and your PC 
 

(f) Check that your PC wireless networking is switched ON and is “Connected” 
 

(g) Launch the Driver Station from the Windows “Start” page – search for “FRC Driver Station”. 
Alternatively, if you have a driver station icon on your desktop you can launch it from there: 

 

https://wpilib.screenstepslive.com/s/4485/m/13811/l/145335-creating-building-and-loading-your-benchtop-test-program
https://wpilib.screenstepslive.com/s/4485/m/13811/l/145335-creating-building-and-loading-your-benchtop-test-program
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(h) Set your team number in the Driver Station: 
 

 Select the settings tab. 

 Enter your team number – this needs to be the same as the team number used 
when you configured the radio in the exercise 2 

 

(i) Plugin the joystick – the “LED” next to “Joysticks” should go green 
 

(j) At this point there should be two green indicators (“Communications” and “Joysticks”) and 
one red indicator (“Robot Code”) in the centre of the Driver Station 
 

(k) Launch LabVIEW as described in the previous exercise 
 

(l) Select your project in the “FRC 2015 Getting Started” window 
 

(m) We can now “run” the program: 
 

 In the LabVIEW “Project Explorer” window double click on the “Robot Main.vi” 
that is listed under “Target (roboRIO-XXXX.local)” (if you have followed the steps 
above then the “XXXX” should be your team number) 

 In the “Robot Main.vi Front Panel” window, select the “Run” button (White 
Arrow on the top menu bar). This will deploy the Robot Main program (VI) and all 
dependencies to the roboRIO (if prompted to save any Vis select “Save” in all cases) 
– wait for all three indicators in the centre of the Driver Station to be green 

 In the “FRC Driver Station” window select “Teleoperated” Mode (the diagram 
below shows that “Teleoperated” mode has been selected and not the 
“Autonomous”, “Test” or “Practice” modes) 

 Double check that robot is up on the wooden blocks and the wheels are free to 
turn then select “Enable” 
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(n) Move the joystick and observe how the robot responds 
 

(o) Select the “Abort” button in the “Robot Main.vi Front Panel” window - notice that the 
program (VI) stops 
 

(p) When you deploy a program with the Run button, the program runs on the roboRIO, but you 
can manipulate the front panel objects of the program from the host computer 

 

NOTE: a program deployed in this manner will not remain on the roboRIO after a 
power cycle. To deploy a program to run every time the roboRIO starts follow the 
next step, Deploying the program. 

 

EXERCISE 6: permanently installing your program on the roboRIO 
 

You may have noticed that each time you turn off your robot in the previous exercises you need to 
re-run the program to deploy the project to the roboRIO before you can start to drive the robot. 

When you are at a tournament you do not get the opportunity to do this, you simply position your 
robot on the field and turn it on. You need to have previously loaded your program so that it 
automatically loads from on-board memory. The instructions in this exercise describe how to do this.  

 

NOTE: once your program is on the robot, in principle, any driver station can 
connect to your robot and drive it. This is where the classmate can be put to best 
use – because you are not re-compiling your software you can use a much lower 
spec PC like the classmate to just run the driver station software and 
communicate with your robot program that is running on the roboRIO. 
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NOTE: If you have any difficulties downloading code to your robot in this exercise 
then repeat the radio configuration exercise. 

 

 (CREDIT: https://wpilib.screenstepslive.com/s/4485/m/13811/l/145335-creating-building-and-
loading-your-benchtop-test-program) 

(a) Complete the steps in the previous exercise to confirm that you have connection with the 
robot and that the code you are about to deploy does what you need it to 
 

(b) Deploy your program: 
 

 In the LabVIEW “Project Explorer”, select the “+” next to “Build Specifications” 
to expand the folder under “Target (roboRIO-XXXX.local)” 

 Right-click on “FRC Robot Boot-up Deployment” and select “Build” 

 Wait for the build to complete then right-click again on “FRC Robot Boot-up 
Deployment” and select “Run as startup” (if you receive a conflict dialog, select “OK” 
- this is just warning you that there is currently a program on the roboRIO which will 
be terminated and replaced) 

 

(c) Either check the box to close the deployment window on successful completion or click the 
close button when the deployment completes 
 

https://wpilib.screenstepslive.com/s/4485/m/13811/l/145335-creating-building-and-loading-your-benchtop-test-program
https://wpilib.screenstepslive.com/s/4485/m/13811/l/145335-creating-building-and-loading-your-benchtop-test-program
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(d) The roboRIO will automatically start running the deployed code within a few seconds of the 
dialog closing. 
 

(e) Now turn off your robot 
 

(f) Power it up again and confirm that you can re-establish communication between the robot 
and the driver station – all three indicators in the centre of the Driver Station should be 
green 
 

(g) If you enable the Driver Station you can use the joystick to control the robot again 

Did you notice that you did not need to use LabVIEW at all in the last three steps? You just turned on 
the robot and connected the PC using the driver station … your robot may not be complete but you 
have now completed all of the software steps necessary to participate in an FRC tournament, well 
done! 

 

EXERCISE 7: finding your way around the default project 
 

When you click on the “FRC roboRIO Project” (as you did in exercise 4) the new project that is 
created will contain a number of sub-programs / modules. In LabVIEW these sub-programs / 
modules are called “Virtual Instruments” or “VIs”. The VIs in a new “FRC roboRIO Project” are in 
alphabetical order: 

• Autonomous Independent VI 
• Begin VI 
• Build DashBoard Data VI 
• Disabled VI 
• Finish VI 
• Periodic Tasks VI 
• Robot Global Data VI 
• Teleop VI 
• Vision Processing VI 

For this exercise, open the project as described in exercise 4 and then expand the “Team Code” 
folder in the LabVIEW Project Explorer window - just open each of these VIs by double clicking on 
the VI name.  Scroll around the VI to see the different parts – note that each VI has two views: Front 
Panel view and Block Diagram view. You can switch between these views using CTRL+E keys. 
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NOTE: you can also open a VI by double clicking on the icon within another VI (for 
example the “Robot Main VI” contains icons for each of the team code VIs). 

 

(CREDIT: http://www.ni.com/pdf/manuals/372668d.pdf) 

(a) Autonomous Independent VI 

The Autonomous Independent VI is one of two VIs you can choose to run during the 
Autonomous portion of the FRC competition. This VI runs for the duration of the 
Autonomous portion of the competition. You do not need to program the Autonomous 
Independent VI to stop after a certain time because the Robot Main VI terminates this VI 
when the competition mode changes to Teleop. 

(b) Begin VI 

The Begin VI initializes data for use throughout the Robot Main VI. You can open references 
to motors and sensors you want to use, load settings from file, and perform other 
initialization tasks. 

(c) Build DashBoard Data VI 

The Build DashBoard Data VI sends I/O data from the modules on the roboRIO device 
through the driver station to the host computer. You can use the Dashboard Enables input of 
this VI to specify what data you want to send. By default, the Dashboard Enables input 
specifies to send raw data for the first analogue module, the first digital module, and the 
solenoid module to the host computer. The Build DashBoard Data VI also updates data 
values in the Dashboard Datatype type definition, which you then can reuse in other VIs. 

(d) Disabled VI 

The Disabled VI runs whenever the robot is in Disabled status. You can use this VI to 
calibrate sensors or the Axis camera before the FRC competition or between the 
Autonomous and TeleOp portions of the competition. 

(e) Finish VI 

The Finish VI performs clean up tasks before the Robot Main VI stops. This VI runs when you 
press the Finish button on the front panel of the Robot Main VI. 

(f) Periodic Tasks VI 

The Periodic Tasks VI performs periodic tasks. For example, you might include PID VIs to 
perform time-based control operations. This VI runs continuously while the Robot Main VI is 
running. 

http://www.ni.com/pdf/manuals/372668d.pdf
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(g) Robot Global Data VI 

Use the Robot Global Data VI to access and pass data among several VIs. In particular, you 
can use this global VI to store device reference information for the various motors and 
sensors of your robot. 

(h) Teleop VI 

The Teleop VI iterates and performs some action each time a packet specifying the Teleop 
mode arrives from the driver station. This VI only handles the event of the competition 
mode being set to Teleop. Use the Periodic Tasks VI to program the actual behaviour of the 
robot during the Teleop portion of the competition. 

(i) Vision Processing VI 

The Vision Processing VI acquires images from the Axis camera and performs image 
processing. This VI runs continuously while the Robot Main VI is running. 

 

EXERCISE 8: controlling an additional motor 
 

Your team will be quickly devising ideas and solutions to the FRC challenge that require more than 
the base robot.  You will want to add motors, pneumatic devices, sensors and maybe eventually 
custom electronics modules and driver station dashboards and switches etc. 

In this section we show how to add a single motor controlled by switches on the joystick using 
LabVIEW.  

Once you become familiar with LabVIEW you will discover that it is much quicker to copy and paste 
existing parts than it is to locate them in the LabVIEW menus. When we edit the “Begin.vi” below we 
have provided full instructions for constructing from parts in the Function palette – you will soon 
learn to copy and paste but it is worth manually constructing the Begin.vi so that you know what to 
do when a part is not available for copy and paste. 

The first steps of the tutorial show you exactly where to find items in the LabVIEW menus and 
palettes but as the tutorial progresses it will be less explicit and you may need to refer back to these 
earlier steps to see how to complete a particular task. 

Ok, lets get started. 

Select “Start” and search for "NI LabVIEW 2014" to launch the “FRC Getting Started” window. 
Alternatively you can select the following icon on your desktop if it is present: 
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In the "FRC Getting Started" window select the "Projects" tab on the left and then select "2015 
Robot Project.lvproj" (if you called your project by a different name then use that name here 
instead). Wait for the program to load. 

In the "Project Explorer" window select the "Items" tab then expand "Project: 2015 Robot 
Project.lvproj" > "Target (roboRIO-XXXX.local)" > "Team Code". Again, if you called your project by a 
different name then that name will show here instead. 

We need to modify the Begin, Finish and Periodic Tasks VIs, these are covered in the following sub-
sections. It is recommended that you follow them in the order shown as this is the order that you 
should get in the habit of applying modifications: 

a. use the Begin VI to declare all new hardware 
b. in the Finish VI close down all new hardware 
c. now modify the other VIs as required to define the behaviour of the new hardware 

 

EXERCISE 8.1: modifying the begin.vi 
 

Select "Begin.vi" in the "Project Explorer" window then right-click and select "Open". 

Use "CTRL+E" to toggle between the "Begin.vi Front Panel" window and the and "Begin.vi Block 
Diagram" window. 

In the "Begin.vi Block Diagram" window we will now configure a new motor object: 

(a) Right-click on the white background, the "Functions" palette will appear, select the "Pin" in 
the top left corner to keep the palette visible (you can also get to the palette via the menu 
"View" > "Functions Palette"): 

 

(b) In the "Functions" palette, select "WPI Robotics Library" > "Actuators" > "Motor Control" 
then select the "WPI_MotorControlRefNumRegistry Set.vi" then left click on the white 
background to drop the VI. By the way, the "WPI_MotorControlRefNum Registry Set.vi" 
looks like this: 

 

(c) Repeat the previous step for the "WPI_MotorControlSafetyConfig.vi", it looks like this: 
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(d) Repeat again for the "WPI_MotorControl Open.vi" which looks like this on the palette: 

 

but it changes appearance when you drop it on the Begin VI, it now looks like this: 

 

 

NOTE: This last step highlights an important point and is something to be aware of 
when searching for an existing VI in the Functions palette – the icon in the pallet 
may be somewhat different to that in your project. Also take tare as many of the 
icons appear similar, for example the “Drive” and “Motor” VIs are very easy to 
confuse. 

 

(e) Using the dropdown list on the "WPI_MotorControl Open.vi" change the motor controller 
type to match the motor controller on your robot, ours are all talons, if yours are too then 
the default is fine. 
 

(f) Click on the Cross in the top right of the "Functions" palette to close it. 
 

(g) You may want to move the VIs around on the diagram, use "SHIFT" + right click to display the 
"Tools" palette and left click on the "select arrow": 

 

(h) Note that like the "Functions" palette you can "pin" the "Tools" palette to keep it visible. You 
can also access the "Tools" palette from the menu via "View" > "Tools Palette". 
 

(i) You can now select the VIs and move them using the drag and drop method (i.e. left click 
with mouse and hold it down as you move the mouse, the VI will change to a dotted outline, 
relocate the VI and then release the left mouse button in the new location. You can also 
release the mouse and use the arrow keys on your keyboard to move the VI around more 
precisely (albeit very slowly!). When you have finished moving the VI, left-click on the white 
background to de-select it. 
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(j) You now need to wire the VIs together, first, select the "wire spool" tool in the tools palette: 

 

(k) We now need to connect the parts together that we have paced into the Begin VI. Start by 
moving the mouse over one of the VIs, you will see that the connection points will become 
visible: 

 

(l) Move the mouse until a black square is visible next to the connection you want to use: 

 

(m) Now left-click and drag the wire over to the connection point on another VI. On the target VI 
another black square will flash to show you which connection point is about to be used, 
release the left mouse button and the wire will change from a dotted line to a solid line 
showing that it has connected successfully: 

 

(n) Repeat this until you have wired the three VIs together to look like this: 

 

(o) The next step is to configure the VIs. Let’s start by creating a string constant and wiring it 
into the "refnum name" input of the "WPI_MotorControlRefNum Registry Set.vi" - you can 
do this by first selecting the wire spool tool (see above) and then moving the mouse over the 
"refnum name" connector on the VI then right-click and select "Create" > "Constant". Notice 
that the connection names pop-up as you move the mouse over each of the connections on 
the VI. Now change to the “Selector” tool and triple left-click in the constant (that means 
click the left mouse button three times in quick succession) to select the text, you can then 
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type a suitable name for the controller (e.g. "Lift Motor"). You may want to move the 
constant to make the diagram easier to follow - use the steps described above for selecting 
and moving parts. When you are done you should have something looking like this: 

 

(p) If you are having difficulty changing the text in the string constant, select the "Hand" in the 
"Tools" palette and then left-click on the constant and use the keyboard to edit the text: 

 

(q) Some inputs to VIs are very specific and can be configured using a drop-down list. LabVIEW 
is smart enough to work this out for itself - simply repeat the previous steps for the "mode" 
input on the "WPI_MotorControlSafetyConfig.vi" and you will see that a blue constant is 
displayed - it has automatically worked out that the only permissible values for this input are 
"Enable" and "Disable" so this is presented to the user as a drop down list rather than a free 
text field, set this to "enable" (remember, if you are having trouble setting these constants 
use the "Tools" palette to elect the "Hand" mode and then left click on the constant to edit 
it: 

 

(r) Repeat this for the "PWM Channel" input on the "WPI_MotorControl Open.vi": 

 

(s) You should end up with a diagram looking like this: 
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(t) Save and close the Begin.vi using CTRL+S then CTRL+W (or via the menu at "File" > "Save" 
then "File" > "Close") 

 

EXERCISE 8.2: modifying the finish.vi 
 

Select "Finish.vi" in the "Project Explorer" window then right-click and select "Open". 

Toggle the display to show the "Finish.vi Block Diagram" window. 

In the "Finish.vi Block Diagram" window we will now add “WPI_MotorControlRefNum Registry 
Get.vi” and a “WPI_MotorControlClose.vi” and configure them for the new motor that we added to 
the Begin VI. 

Using the techniques described above, add a motor close VI to the Finish VI and configure it so that it 
looks like this: 

 

Appendix C provides a handy list of the VIs that we refer to in these exercises and also contains some 
hints for finding these parts in the LabVIEW function palette. 

 

EXERCISE 8.3: modifying the Periodic Tasks.vi: 
 

Select "Periodic Tasks.vi" in the "Project Explorer" window then right-click and select "Open". 

Toggle the display to show the "Periodic Tasks.vi Block Diagram" window. 

Using the techniques described above, add parts to the 100ms loop so that it looks like the following 
diagram. Note that you can delete the “Left/Right and Drive” objects as we are not going to be 
making use of these in the “Periodic Tasks” VI. 

Appendix C provides a handy list of the VIs that we refer to in these exercises and also contains some 
hints for finding these parts in the LabVIEW function palette. 
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In this exercise we have edited three different VIs – you can spot a VI that has been edited because 
there is an asterisk next to the filename in the VI title bar of the window. You can save VIs using the 
CTRL+S keys or via the menu using “File” > “Save”. 

Assuming your robot is switched on and connected, you can now select the “Run” button in the 
LabVIEW Project Explorer window to download your program for testing as you did in exercise 4 … 
before you do so don’t forget: Goggles on. Robot on the wooden blocks! 

 

TAKE CARE: the motor is entirely under manual control. Although we do have limit 
switches installed in Fluffy the program that we have created here will not pay 
any attention to those switches so you can cause damage to the robot and the 
drive motor if you try to make the motor move the gantry beyond the designed 
range of travel. 

 

The buttons on the joystick should: 

• In the case of button 11: cause the motor be running or off 
• In the case of button 12: cause the direction of the motor to change 
• The speed of the motor is controlled by the “Motor Speed” variable on the front panel of the 

“Periodic Tasks” VI, you can set this to a value between 0 and 1 (for the lift motor on Fluffy 
we found 0.4 was a good value to use) 

You should now have remote control over the “lift motor”: 

• Hold button 11 to make the motor go in one direction 
• Hold buttons 11 and 12 to make the motor go in opposite direction 
• Release both buttons to make the motor stop 
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Appendix A – relevant parts for the base robot 
 

All of the necessary parts for the exercises described in this document are already fitted to i c 
robotics’ Fluffy. 

If you do not have access to Fluffy or an equivalent then ask your hardware team to assemble the 
drive base using the kit of parts (KOP). 

The diagram below shows the complete control system supplied with the 2015 KOP. Note that the 
only electro mechanical parts that you need to complete the initial exercise in this document are: 

• 1 x NI roboRIO 
• 1 x Bridge / Access Point 
• 1 x Power Distribution Panel (PDP) with breakers installed (see note #1) 
• 1 x Battery (charged and/or charger) 
• 1 x Main Breaker 
• 2 x Talon Motor Controllers 
• 2 x Motors 
• 1 x Robot Signal Light 
• 1 x Voltage Regulator Module (VRM) (see note #2) 
• 2 x PWM Cables for the Motor Controllers 
• 1 x Ethernet cable for Bridge / Access Point (see note #3) 
• Red and Black power cable as required (see note #1) 

If you go on to complete the additional exercise you will need: 

• 1 x additional Talon Motor Controller 
• 1 x additional Motor 
• 1 x additional PWM Cable for the additional Motor Controller 
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NOTE #1: red and black cables and PDP circuit breakers need to be appropriately sized to carry the 
required currents – refer to Power Distribution section in the FRC Game Manual (section 4.8 in REF 
#02). 

NOTE #2: diagram does not show it but the VRM is used to power the Bridge / Access Point. 

NOTE #3: diagram shows the Bridge / Access Point connected to the NI roboRIO by USB, this is 
incorrect, it should be connected via Ethernet. The Ethernet Camera (if you have one) should be 
connected to the  Bridge / Access Point and not directly to the NI roboRIO as shown. 
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Appendix B – recommended specification for a PC to run LabVIEW 
 

This is the recommended spec from http://www.ni.com/labview/requirements/  

Processor Pentium 4M (or equivalent) or later (32-bit) 
Pentium 4 G1 (or equivalent) or later (64-bit) 

RAM 1 GB 

Screen Resolution 1024 x 768 pixels 

OS Windows 8.1/8/7/Vista (32-bit and 64-bit) 
Windows XP SP3 (32-bit) 
Windows Server 2012 R2 (64-bit) 
Windows Server 2008 R2 (64-bit) 
Windows Server 2003 R2 (32-bit) 

Disk Space 5 GB (includes default drivers from NI Device 
Drivers DVD) 

 

 

  

http://www.ni.com/labview/requirements/
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Appendix C – parts location in LabVIEW libraries 
 

Part Symbol Part Name Location in Functions Palette 

 
Index Array “Programming” > 

“Array” 

 
Numeric Constant “Programming” > 

“Numeric” 

 
Multiply “Programming” > 

“Numeric” 

 
Select “Programming” > 

“Comparison” 

 

Free Label 
“Programming” > 

“Structures” > 
“Decorations” 

 
DBL Numeric Constant “Programming” > 

“Numeric” 

 
WPI_JoystickRefNum Registry Set "WPI Robotics Library" > 

"Joystick" 

 
WPI_JoystickGetValues "WPI Robotics Library" > 

"Joystick" 

 

 

Enum Constant 

(the easiest way to create 
these is to hover over parent 
VI with wiring tool, right-click 

and select “Create” > 
“Constant” – this will 

automatically create an Enum 
Constant of the correct type) 

 

 

String Constant “Programming” > 
“String” 

 Bundle By Name “Programming” > 
“Cluster, Class & Variant” 

 

 
Unbundle “Programming” > 

“Cluster, Class & Variant” 

 

WPI_MotorControlOpen 
"WPI Robotics Library" > 

"Actuators" > 
"Motor Control" 

 
WPI_MotorControlSafetyConfig 

"WPI Robotics Library" > 
"Actuators" > 

"Motor Control" 

 
WPI_MotorControlRefNum Registry Set 

"WPI Robotics Library" > 
"Actuators" > 

"Motor Control" 
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WPI_MotorControlRefNum Registry Get 

"WPI Robotics Library" > 
"Actuators" > 

"Motor Control" 

 
WPI_MotorControlSetOutput 

"WPI Robotics Library" > 
"Actuators" > 

"Motor Control" 

 
WPI_MotorControlClose 

"WPI Robotics Library" > 
"Actuators" > 

"Motor Control" 
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